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Chapter 436

Tests for the
Difference Between
Two Poisson Rates
Introduction
The Poisson probability law gives the probability distribution of the number of events occurring in a specified
interval of time or space. The Poisson distribution is often used to fit count data, such as the number of defects on an
item, the number of accidents at an intersection during a year, the number of calls to a call center during an hour, or
the number of meteors seen in the evening sky during an hour.
The Poisson distribution is characterized by a single parameter which is the mean number of occurrences during the
specified interval.
The procedure documented in this chapter calculates the power or sample size for testing whether the difference of
two Poisson rates is different from zero.

Technical Details
These results follow Mathews (2010). Assume that all subjects in each group are observed for a fixed time period
(which we set as one without loss of generality and the number of events (outcomes or defects) is recorded. The
following table presents the various terms used.
Group

1

2

Sample Size

N1

N2

Number of Events

X1

X2

Event Rate

λ1

λ2

Distribution of X

Poisson(λ1)

Poisson(λ2)

Mathews (2010) proposed two test statistics that can be used to test statistical hypotheses about the rate difference.
The first is based is the large-sample z-test of the hypotheses H0: λ1 = λ2 versus Ha: λ1 ≠ λ2.
𝑧𝑧𝐿𝐿𝐿𝐿 =

𝜆𝜆̂2 − 𝜆𝜆̂1

̂
̂
� 𝜆𝜆1 + 𝜆𝜆2
𝑁𝑁1 𝑁𝑁2

where 𝜆𝜆̂𝑖𝑖 = 𝑋𝑋𝑖𝑖 /𝑁𝑁𝑖𝑖 . This test is appropriate when Xi > 30.
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The power of the two-sided level α hypothesis test is given by
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where 𝑧𝑧𝑥𝑥 = Φ(𝑥𝑥) is the standard normal distribution function.

The second test is the square root transform version of the first. The square root transform helps the test statistic
approach normality for smaller sample sizes. It is given by
𝑧𝑧𝑆𝑆𝑆𝑆 =
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are λ2, Sample Size, and Power.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found.

Test
Alternative Hypothesis
Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the
hypothesis test direction is chosen based on whether the event rate difference (λ2-λ1) is greater than or less than 0.
The options are
•

Two-Sided
The null and alternative hypotheses are
𝐻𝐻0 : 𝜆𝜆2 − 𝜆𝜆1 = 0 vs. 𝐻𝐻𝐴𝐴 : 𝜆𝜆2 − 𝜆𝜆1 ≠ 0
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•

One-Sided
The upper and lower null and alternative hypotheses are
Upper: 𝐻𝐻0 : 𝜆𝜆2 − 𝜆𝜆1 ≤ 0 vs. 𝐻𝐻𝐴𝐴 : 𝜆𝜆2 − 𝜆𝜆1 > 0

Lower: 𝐻𝐻0 : 𝜆𝜆2 − 𝜆𝜆1 ≥ 0 vs. 𝐻𝐻𝐴𝐴 : 𝜆𝜆2 − 𝜆𝜆1 < 0

Test Statistic
Two test statistics are available to test whether the difference between two event rates is significantly different
from zero: Large Samples and Square-Root Transform.
•

Large Samples
Large samples are designated as those in which N1 x λ1 > 30 and N2 x λ2 > 30. When this sample size
requirement is met, the distribution of the difference of the sample event rates as approximately normal and so
it can be used as a test.

•

Square-Root Transform
If the sample size requirements above are not met, the difference of the square roots of the sample event rates
tends toward normality more quickly. Thus, it can be used as a test.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis
is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90
(beta = 0.10) is commonly used.
A single value may be entered or a range of values, such as 0.8 to 0.95 by 0.05, may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for two-sided tests and 0.025 is used for
one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.
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•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
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Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
λ1 (Event Rate of Group 1)
Enter a value (or range of values) for the mean event rate per unit time in group 1 (control group). The value must
be greater than zero. This value is compared to λ2 by the statistical test. The difference in the rates, λ2 - λ1, is the
amount that this design can detect.
Enter a value (or range of values) for the mean event rate per time unit in the control group (group 1).
Example of Estimating λ1
If 200 patients were exposed for 1 year and 40 experienced the event of interest, then the mean event rate would
be
λ1 = 40/(200*1) = 0.2 per patient-year
If 200 patients were exposed for 2 years and 40 experienced the event of interest, then the mean event rate would
be
λ1 = 40/(200*2) = 0.1 per patient-year
Event Rate Difference
λ1 is used with λ2 to calculate the event rate difference as
Diff = λ2 - λ1
such that
λ1 = λ2 - Diff
The range of acceptable values is λ1 > 0. You can enter a single value such as 1 or a series of values such as 1 to 2
by 0.5.
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Enter λ2, Diff, or Ratio for Group 2
This option lets you indicate how you want to enter λ2. The options are
•

λ2 (Event Rate of Group 2)
Enter the value of λ2 directly.

•

Diff (Difference Between Event Rates)
Enter values for the difference between the event rates (Diff = λ2 - λ1). The value of λ2 is equal to λ1 + Diff.

•

RR (Ratio of Event Rates)
Enter values for the ratio of the event rates (RR = λ2/λ1). The value of λ2 is equal to λ1 x Ratio. Note that the
hypothesis still concerns the difference. This is just a convenient way of specifying a value.

λ2 (Event Rate of Group 2)
This option is displayed only if Enter λ2, Diff, or Ratio for Group 2 = “λ2 (Event Rate of Group 2).”
Enter a value (or range of values) for the mean event rate per time unit in group 2 (treatment group). The value
must be greater than zero and different from λ1. This value is compared to λ1 by the statistical test. The difference
in the rates, λ2 - λ1, is the amount that this design can detect.
Example of Estimating λ2
If 200 patients were exposed for 1 year and 40 experienced the event of interest, then the mean event rate would
be
λ2 = 40/(200*1) = 0.2 per patient-year
If 200 patients were exposed for 2 years and 40 experienced the event of interest, then the mean event rate would
be
λ2 = 40/(200*2) = 0.1 per patient-year
Event Rate Difference
λ2 is used with λ1 to calculate the event rate difference as
Diff = λ2 - λ1
such that
λ2 = λ1 + Diff
The range of acceptable values is λ2 > 0. You can enter a single value such as 1 or a series of values such as 1 to 2
by 0.5.
λ2 (Event Rate of Group 2) [when solving for λ2 (Event Rate of Group 2)]
If you are solving for λ2, this option will let you indicate whether you want to search less than or greater than λ1.
Diff (Difference Between Event Rates)
This option is displayed only if Enter λ2, Diff, or Ratio for Group 2 = “Diff (Difference Between Event Rates).”
Enter values for the difference between the event rates (Diff = λ2 - λ1). The value of λ2 is equal to λ1 + Diff.
The range of acceptable values is any positive or negative value other than 0 (Diff ≠ 0). You can enter a single
value such as 0.5 or a series of values such as 1 to 2 by 0.5.

436-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for the Difference Between Two Poisson Rates

RR (Ratio Event Rates)
This option is displayed only if Enter λ2, Diff, or Ratio for Group 2 = “RR (Ratio Event Rates).”
Enter values for the ratio of the event rates (RR = λ2/λ1) at which the power is to be calculated. The value of λ2 is
calculated using λ1 x RR.
The range of acceptable values is RR > 0 and RR ≠ 1.
You can enter a single value such as 1.15 or a series of values such as 1.05 to 1.20 by 0.05.

Example 1 – Calculating Sample Size
Suppose that a study is to be conducted in which λ1 = 1, λ2=1.1 1.2 1.3 1.4, power = 0.9, and alpha = 0.05. The
sample size is to be calculated for a two-sided, large-samples test. The design is to have an equal sample size in
each arm.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Difference Between Two Poisson Rates procedure window. You may then make
the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Test Statistic ........................................... Large Samples
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation: .................................... Equal (N1 = N2)
λ1 (Event Rate of Group 1) ..................... 1
Enter λ2, Diff, or Ratio for Group 2 ......... λ2 (Event Rate of Group 2)
λ2 (Event Rate of Group 2) ..................... 1.1 1.2 1.3 1.4

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing the Difference Between Two Poisson Rates
Alternative Hypothesis: Two-Sided
Group 1: Control
Test Statistic:
Large-Sample
Group 2: Treatment

Power
0.90006
0.90005
0.90050
0.90070

N1
2207
578
269
158

N2
2207
578
269
158

N
4414
1156
538
316

Grp 1
Event
Rate
λ1
1.00
1.00
1.00
1.00

Grp 2
Event
Rate
λ2
1.10
1.20
1.30
1.40

Diff
λ2-λ1
0.10
0.20
0.30
0.40

Ratio
λ2/λ1
1.1000
1.2000
1.3000
1.4000

Alpha
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N1 and N2 are the number of subjects in groups 1 and 2, respectively.
N is the total sample size. N = N1 + N2.
λ1 is the mean event (or incidence) rate of group 1, the control, reference, or baseline group.
λ2 is the mean event (or incidence) rate of group 2, the treatment group.
λ2-λ1 is the difference between the two event rates.
λ2/λ1 is the ratio of the two event rates.
Alpha is the probability of rejecting the null hypothesis when it is true. It should be small.
Summary Statements
A total sample size of 4414 subjects with 2207 in group 1 and 2207 in group 2, each measured
for a fixed duration, achieves 90.006% power to detect a difference of 0.10 between the group 2
(treatment) event rate of 1.10 and the group 1 (control) event rate of 1.00 using a two-sided,
large-samples z-test of the Poisson event-rate difference at a significance level of 0.050.

This report shows the sample size for each of the scenarios.

Plots Section

This plot shows the sample size versus the group 2 event rate.
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Example 2 – Validation using Mathews (2010)
Mathews (2010) on page 126 presents a power calculation for this test. For the values λ1 = 10, λ2=15, alpha =
0.05, N1 =8, and N2 = 6, the power is shown to be 0.826 for a one-sided test.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Difference Between Two Poisson Rates procedure window. You may then make
the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ One-Sided
Test Statistic ........................................... Large Samples
Alpha ....................................................... 0.05
Group Allocation: .................................... Enter N1 and N2 individually
N1 ........................................................... 8
N2 ........................................................... 6
λ1 (Event Rate of Group 1) ..................... 10
Enter λ2, Diff, or Ratio for Group 2 ......... λ2 (Event Rate of Group 2)
λ2 (Event Rate of Group 2) ..................... 15

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing the Difference Between Two Poisson Rates
Alternative Hypothesis: One-Sided
Group 1: Control
Test Statistic:
Large-Sample
Group 2: Treatment

Power
0.82566

N1
8

N2
6

N
14

Grp 1
Event
Rate
λ1
10.00

Grp 2
Event
Rate
λ2
15.00

Diff
λ2-λ1
5.00

Ratio
λ2/λ1
1.5000

Alpha
0.050

PASS calculates the same power.
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